




RANCANGAN PELAJARAN TAHUNAN

ASAS SAINS KOMPUTER TINGKATAN 1 


	MINGGU
	STANDARD KANDUNGAN
	STANDARD PEMBELAJARAN
	CADANGAN AKTIVITI
	CATATAN

	BIDANG PEMBELAJARAN : 1.0 KONSEP ASAS PEMIKIRAN KOMPUTASIONAL
	

	MINGGU 1
KUMPULAN A

10 Mac – 14 Mac 2024
KUMPULAN B
11 Mac – 15 Mac 2024
	1.1 AsasPemikiranKomputasional
	1.1.1 MenerangkanteknikLeraian

(Decomposition), PengecamanCorak

(Pattern Recognition), Peniskalaan

(Abstraction) danPengitlakan

(Generalisation) dalampemikiran

komputasionaluntukmenyelesaikan

masalah.
	Menyenaraikanempatteknikpenyelesaian

masalah yang terdapatdalampemikiran

komputasional.
Penyelesaianmasalahberdasarkansituasi yang diberimelaluiaktivitiberkumpulan
aktivitipermainanpemikirankomputasionalatastalian
http://games.thinkingmyself.com/
http://www.bbc.co.uk/education/guides/zqqfyrd/revision
	

	MINGGU 2
KUMPULAN A

17 Mac – 21 Mac 2024
KUMPULAN B
18 Mac – 22 Mac 2024
	
	1.1.2 Menyelesaikansesuatutugasan

menggunakanteknikleraiandan

menentukanlangkahsecaratertib.
	Contohsituasi:
Bagaimanamengasingkanstokbukubaru di perpustakaan
	

	MINGGU 3
KUMPULAN A

24 Mac – 28 Mac 2024
KUMPULAN B
25 Mac – 29 Mac 2024
	
	1.1.3 Mengesanunsurpersamaandan

perbezaanuntukpengecamancorak

dalamsesuatusituasi.
	Contohsituasi:
Doktormendiagnospesakit
	

	MINGGU 4
KUMPULAN A

31 Mac – 4 April 2024
KUMPULAN B
1 April – 5 April 2024
	
	1.1.4 Membuatkeputusanbagimenentukan

aspekpentingdalamsesuatu

permasalahan.
	Menghasilkan model atauprototaipterhadap

cadanganpenyelesaianmasalah yang ditemui.
Contoh : LawatanSambilBelajar
Pameran ICT
	

	MINGGU 5
KUMPULAN A

7 April – 11 April 2024
KUMPULAN B
8 April – 12 April
2024

	
	
	
	

	MINGGU 6
KUMPULAN A

14 April – 18 April 2024
KUMPULAN B

15 April – 19 April 2024
	
	1.1.5 Menentukanciri-cirikesamaandalam

sesuatupermasalahan.
	Memberijustifikasiteknikpenyelesaianterbaikberdasarkan model yang telahdihasilkan


	

	BIDANG PEMBELAJARAN : 2.0 PERWAKILAN DATA
	

	MINGGU 7
KUMPULAN A

21 April – 25 April 2024
KUMPULAN B
 22 April – 26 APRIL 2024
MINGGU 7
KUMPULAN A

21 April – 25 April 2024
KUMPULAN B
 22 April – 26 APRIL 2024
	2.1 Sistem

Nombor

Perduaan
	2.1.1 Mengenalpastinomborperduaandan

nomborperpuluhan.
	Permainankad binary
http://csunplugged.org/binary-numbers/
	

	
	
	2.1.2 Menukarnomborperduaankepada

nomborperpuluhan.
	Permainankad binary
http://csunplugged.org/binary-numbers/
	

	
	
	2.1.3 Menukarnomborperpuluhankepada

nomborperduaan.
	Permainankad binary
http://csunplugged.org/binary-numbers/
Rujukan : JadualAsasSepuluhdanPerduaan
	

	MINGGU 8
KUMPULAN A

28 April –  2 Mei 2024
KUMPULAN B
29 April – 3 Mei 2024
	
	2.1.4 Melakukanoperasitambahbagiduanilai

nomborperduaan.
	Penyelesaianmasalahoperasitambahdalamnomborperduaan
Rujukan : https://www.khanacademy.org/math/pre-algebra/applying-math-reasoning-topic/alternate-number-bases/v/binary-addition
	

	
	
	2.1.5 Melakukanoperasitolakbagiduanilai

nomborperduaan.


	Penyelesaianmasalahoperasitolakdalamnomborperduaan
Rujukan : https://www.khanacademy.org
	

	MINGGU 9
KUMPULAN A

5 Mei – 9 Mei 2024
KUMPULAN B
6 Mei – 10 Mei 2024
	
	2.1.6 Menggabungkankemahiranoperasi

tambahdanoperasitolaknombor

perduaandalammenterjemahaksara

pengekodan ASCII.
	Aktivitimenggunakanpapankekunciberdasarkanjadual ASCII:
1. Operasimatematik
2. Penukaranaksara
3. Mengejanamasendiri
	

	MINGGU 10
KUMPULAN A

12 Mei – 16 Mei 2024
KUMPULAN B
13 Mei – 17 Mei 2024
	2.2 Ukuran

Data
	2.2.1 Mengenalpasti unit ukuranbagiimej digital dan audio digital
	Demo manipulasiimej digital yang sama:
1. Zoom in
2. Zoom out
Memperdengarkanbeberapasampel audio digital dalamperisian Audacity  
	

	
	
	2.2.2 Membandingsaiz fail imej yang samadalam

pelbagai format melaluitunjukcara:

i. Bitmap (*.bmp)

ii. Joint Photographic Experts Group

(*.jpeg)

iii. Tagged Image File Format (*.tiff)

iv. Graphics Interchange Format (*.gif)
	MuridmelihatkualitiimejmenerusiperisianMs Paint berdasarkan format fail yang diberioleh guru:

i. Bitmap (*.bmp)

ii. Joint Photographic Experts Group

(*.jpeg)
iv. Graphics Interchange Format (*.gif

iii. Tagged Image File Format (*.tiff)

Muridperlumenyimpan (Save As) setiapimejmengikut format fail yang diberi.
	

	MINGGU 11
19 Mei – 23 Mei 2024
KUMPULAN B
20 Mei – 24 Mei 2024
	
	2.2.3 Membandingkankualitidansaizimejapabila

kedalamanwarna (colour depth) danresolusi

bagiimejdikurangkan.
	Aktivitikumpulan (1):
1. Setiapkumpulandiberi 3 set penselwarna( 6batang, 
    12 batang, 24 batang)
2. Ahlikumpulankumpulandikehendakimewarna 3 set 
gambar (contohgambardaun) berdasarkantonawarna
    yang dipilih. Contoh  setwarnatonahijau.
3. Kesemua set gambardibandingkandarisegikepadatan
warna,tondankualiti.

Aktivitikumpulan (2):
1.Mewarnakan gambarmenggunakan 1 ton warnasahaja
   (mengikutkreativitimurid).
2. Bincangkanhasildapatandariaktiviti 1 danaktiviti 2
	

	KUMPULAN A
26 Mei – 30 Mei 2024
KUMPULAN B
27 Mei – 31 Mei 2024
	CUTI PENGGAL 1 
	
	
	

	MINGGU 12
KUMPULAN A
2 Jun – 6 Jun 2024
KUMPULAN B
3 Jun – 7 Jun 2024
	
	2.2.4 Menghubungkaitsaiz audio dengankadar

kedalaman bit (bitrates) bagi audio.
	Aktivitimenggunakanaplikasi Audacity
[image: image1.png]KTVt

Untuk mefihat atau menukar kadar bit serta persampelan
boleh dibuat dengan menggunakan perisian Audacity

1. Lancarkan apikasi Audacity. Kik File>Open... Piin
sat fai audio format * mp3.
D_Kik Edit > Preference

Untuk menukar Kadar persampelan, boleh diubah pada
Default Sample Rate.
5. Untuk menukar Kedalaman bit, Default Sample For-
mat
Kemudian Kik butang OK.
7. Setelah itu untuk menyimpan audio, Kik File>Export
Audio>taip nama fai>Save.





	

	MINGGU 13
KUMPULAN A

9 Jun – 13 Jun 2024
KUMPULAN B
10 Jun – 14 Jun 2024

	
	2.2.5 Membandingkansaiz fail dankualitiuntuk

audio yang samabagi format yang berlainan

melaluitunjukcara:

i. wave (*.wav)

ii. MPEG Layer III (*.mp3)

iii.midi (*.mid)
	Muridmenukar format fail audio audio digital dalamperisian Audacity:
i. wave (*.wav)

ii. MPEG Layer III (*.mp3)

iii.midi (*.mid)
Memberijustifikasidanbandingkankualitibunyi (aktivitihands-on)  
	

	MINGGU 14

KUMPULAN A

16 Jun – 20 Jun 2024
KUMPULAN B
17 Jun – 21 Jun 2024
	
	2.2.6 Menghasilkanpenukaransaiz data dari bit ke

bait, kilobait, megabait, gigabaitdanterabait

bagi fail audio danimej.
	Muridmendapatkankoleksi fail imej digital pelbagaijulatsaizdaripadapelbagaisumberdanmenukarkansaiz fail-fail dalamunit yang berbezadalamsatujadual.Bukuteks ms62.
	

	BIDANG PEMBELAJARAN : 3.0 ALGORITMA
	

	MINGGU 15

KUMPULAN A

23 Jun – 27 Jun 2024
KUMPULAN B
24  – 28 Jun 2024

	3.1 Pembangunan 
Algoritma
	3.1.1 Menulispseudokoddan
melukiscartaalirpelbagaipilihandalampenyelesaianmasalah. 


	Muridmengenal-pastialgoritma, menulispseudokoddanmelukiscartaalirdaricontohsituasi yang diberikancontoh

a) Pemberianhadiahkepadapelajar yang mendapatgred A sahajadalammatapelajaran ASK

b) Penentuangredmarkahujianmatapelajaran ASK samada A, B, C, D atau E.

c) PembeliantiketketamanTemanmengikutkategoriumurdanwarganegara.


	

	
	
	3.1.2 Menulispseudokoddan

melukiscartaalir yang melibatkanulangan. 
	Muridmengenal-pastialgoritma, menulispseudokoddanmelukiscartaalirdaricontohsituasi yang diberikancontoh

a) Memasukkan bola kedalamjaringdenganpeluangcubaan 5 kali

b) Memasukkan air denganmenggunakancawankedalambaldisehinggapenuh


	

	MINGGU 16
KUMPULAN A

30 Jun – 4 Julai 2024
KUMPULAN B
1 Julai – 5 Julai 2024
	
	3.1.3 Mengesanralatdaripada

pseudokoddancartaalirdalam

penyelesaianmasalah. 


	Mengesanralatpadapseudokoddancartaalir yang telahdibinaolehmurid lain.
	

	MINGGU 17
KUMPULAN A

7 Julai – 11 Julai 2024
KUMPULAN B
8 Julai – 12 Julai 2024
	
	3.1.4 Menghasilkanpseudokoddancartaalir yang melibatkan

gabunganpelbagaipilihandan

ulangan.


	Muridmenyediakancartaalirdanpseudokod yang sesuaibagimewakilisesuatualgoritma. 
	

	BIDANG PEMBELAJARAN : 4.0 KOD ARAHAN
	

	MINGGU 18
KUMPULAN A

14 Julai – 18 Julai 2024
KUMPULAN B
15 Julai – 19 Julai 2024
	4.1 

KodArahan
	4.1.1 Menggunakanpemboleh
ubahdan operatormatematikdalamaturcara yang dibangunkan. 


	MuridmenggunakanperisianStratch2.0 untukmembinasatuaturcarasesuatu formula matematiksepertimengira perimeter segiempatsamasisidenganmenggunakanpembolehubahdanoperasimatematik yang sesuai.
	

	MINGGU 19
KUMPULAN A

21 Julai – 25 Julai 2024
KUMPULAN B
22 Julai – 26 Julai 2024
	
	4.1.2 Menghasilkanaturcara yang melibatkanpenggunaanpelbagaipilihan. 


	MuridmenggunakanperisianStracth 2.0 untukmembinaaturcarayengmempunyaipengekodanjenispilihan :if, if..else, if else..if..else
	

	MINGGU 20
KUMPULAN A

28 Julai – 1 Ogos 2024
KUMPULAN B
29 Julai – 2 Ogos 2024
	
	4.1.3 Menghasilkanaturcara yang melibatkanpenggunaanulangan. 


	MuridmenggunakanperisianStracth 2.0 untukmembinaaturcarayengmempunyaipengekodanjenisulangan. Blok-bloksrukturulangandalamStracth 2.0:  forever, repeat, repeat until
	

	MINGGU 21
KUMPULAN A

4 Ogos – 8 Ogos 2024
KUMPULAN B
5 Ogos – 9 Ogos 2024
	
	
	
	

	MINGGU 22
KUMPULAN A

11 Ogos – 15 Ogos 2024
KUMPULAN B
12 Ogos – 16 Ogos 2024
	
	4.1.4 Membangunkanaturcara yang melibatkanpenggunaanpelbagaipilihan, ulangan, pembolehubahdan operator matematik. 


	Muridmembangunkanaturcaradenganmenganalisismasalah, merekabentukaturcara, pengekodan, pengujiandanpenyahpepijatandandokumentasi.
	

	MINGGU 23
KUMPULAN A

18 Ogos – 22 Ogos 2024
KUMPULAN B
19 Ogos – 23 Ogos 2024
	
	4.1.5 Mengujiaturcaradanmembaikiralatpadakodarahan yang dihasilkan.


	Muridmengesanralatdanmembaikiralatdalampengaturcaraanstracth 2.0
	

	MINGGU 24
KUMPULAN A

25 Ogos – 29 Ogos 2024
KUMPULAN B
26 Ogos – 30 Ogos 2024
	4.2 

KodArahan

HTML
	4.2.1 Melakarpapanceritauntukmembinalamansesawang

yangmenggunakankodarahan HTML.


	Muridmelukispapancerita yang logikuntuklamansesawang yang hendakdibina.
	

	MINGGU 25
KUMPULAN A

1 September –  5 September 2024
KUMPULAN B
2 September –  6 September 2024
	
	4.2.2 Menggunakantags dalamaturcara HTML : 

<head>; <title>; <body>dan
<paragraph> .
	Muridmembina tags dalamaturcara HTML

SesiAmali: muridmembina tags dalamaturcara HTML

Rujukan: www.w3schools.com
Perisian yang dicadangkan: MS Word, Notepad, dll


	

	
	
	4.2.3 Menggunaparagraph headings dalamaturcara HTML yang dibina. 


	Muridmembinaparagraph headingsdalamaturcara HTML

SesiAmali: muridmembinaparagraph headingsdalamaturcara HTML


	

	MINGGU 26
KUMPULAN A

8 Sept – 12 Sept 2024
KUMPULAN B
9 Sept – 13 Sept 2024
	
	4.2.4 Menggunakanaturcara HTML untukmenghasilkanBanner, Frame dan Menu 


	MuridmembinaBanner, Frame dan Menu dalamaturcara HTML

SesiAmali: muridmembinaBanner, Frame dan Menu dalamaturcara HTML


	

	KUMPULAN A

15 Sept – 19 Sept 2024
KUMPULAN B
16 Sept – 20 Sept 2024
	CUTI PENGGAL 2 
	
	
	

	MINGGU 27
KUMPULAN A

22 Sept –  26 Sept 2024
KUMPULAN B
23 Sept –  27 Sept 2024
	
	4.2.5 Membinapautanteksdanimejdalamaturcara HTML. 


	Muridmembinapautanteksdanimejdalamaturcara HTML

SesiAmali: muridmembinapautanteksdanimejdalamaturcara HTML


	

	MINGGU 28
KUMPULAN A

29 Sept – 2 Oktober 2024
KUMPULAN B
30 Sept – 3 Oktober 2024

	
	4.2.6 Menulisaturcarauntukmemasukkanimejdalamaturcara HTML. 


	Muridmemasukkanimejdalamaturcara HTML

SesiAmali: muridmembinaimejdalamaturcara HTML


	

	MINGGU 29
KUMPULAN A

5 Oktober – 9 Oktober 2024
KUMPULAN B
7 Oktober – 11 Oktober 2024
	
	
	
	

	MINGGU 30
KUMPULAN A

13 Oktober – 16 Oktober 2024
KUMPULAN B
14 Oktober – 17 Oktober 2024
	
	4.2.7 Menghasilkanpull down menu melaluiaturcara HTML. 


	Muridmembinapull down menudalamaturcara HTML

SesiAmali: muridmembinapull down menudalamaturcara HTML


	

	MINGGU 31
KUMPULAN A

20 Oktober – 24 Oktober 2024
KUMPULAN B
21 Oktober – 25 Oktober 2024
	
	
	
	

	MINGGU 32
KUMPULAN A

27 Oktober – 31 Oktober 2024
KUMPULAN B
28 Oktober – 1 November 2024
	
	4.2.8 Menghasilkanruangkomenmelaluiaturcara HTML. 


	Muridmembinaruangkomendalamaturcara HTML

SesiAmali: muridmembina tags dalamaturcara HTML

a) 
	

	MINGGU 33
KUMPULAN A

3 November – 7 November 2024
KUMPULAN B
4 November – 8 November 2024
	
	
	
	

	MINGGU 34
KUMPULAN A

10 November – 14 November 2024
KUMPULAN B
11 November – 15 November 2024
	
	4.2.9 Mengesansebarangralat yang berlakudalamaturcara

HTML yang dibina. 


	Muriddikehendakimembuatujiandanmengesanralat yang berlakudalamaturcara HTML yang telahdibina


	

	MINGGU 35

KUMPULAN A

17 November – 21 November 2024
KUMPULAN B
18 November – 22 November 2024
	
	
	
	

	MINGGU 36

KUMPULAN A

24 November – 28 November 2024
KUMPULAN B
25 November – 29 November 2024
	
	4.2.10 Membinalamansesa

wanginteraktif yang memaparkan

Banner, Menu, Ruangan Komen, 

Frame danPull down menu

	Membinasatulamansesawangpengajaran yang mengandungi:

b) Banner, Frame dan Menu

c) Pautanteksdanimej

d) Mengunakan pull down menu

Menghasilkansaturuangankomen
	

	MINGGU 37

KUMPULAN A

1 Disember – 5 Disember 2024
KUMPULAN B
2 Disember –  6 Disember 2024
	
	
	
	

	MINGGU 38
KUMPULAN A

8 Disember – 12 Disember 2024
KUMPULAN B
9 Disember – 13 Disember 2024
	
	
	
	

	MINGGU 39
KUMPULAN A

15 Disember – 19 Disember 2024
KUMPULAN B
16 Disember – 20 Disember 2024
	
	
	
	

	KUMPULAN A
22 Disember – 26 Disember 2024
KUMPULAN B
23 Disember – 27 Disember 2024
	CUTI PENGGAL 3
	
	
	

	MINGGU 40
KUMPULAN A

29 Disember – 2 Januari 2025
KUMPULAN B
30 Disember – 3 Januari 2025
	
	
	
	

	MINGGU 41
KUMPULAN A

5 Januari – 9 Januari 2025
KUMPULAN B
6 Januari – 10 Januari 2025
	
	
	
	

	MINGGU 42
KUMPULAN A

12 Januari – 16 Januari 2025
KUMPULAN B
13 Januari – 17 Januari 2025
	
	
	
	

	MINGGU 43
KUMPULAN A

19 Januari – 23 Januari 2025
KUMPULAN B
20 Januari – 24 Januari 2025
	CUTI AKHIR PERSEKOLAHAN
	
	
	


